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1 硬件架构 

1.1 系统架构 
Gowin_EMPU_M1 包括三级结构，如图 1-1 所示。 

图 1-1 系统架构 

 
 

第一级，Cortex-M1 内核及 ITCM、DTCM。 

第二级，AHB 总线及 GPIO、CAN、Ethernet、DDR3 Memory、PSRAM、

SPI-Flash、AHB Master [1-6]。 

第三级，APB 总线及 UART0、UART1、Timer0、Timer1、Watch Dog、
RTC、TRNG、DualTimer、I2C Master、SPI Master、SD-Card、APB Master 
[1-16]。 

1.2 系统特征 
Gowin_EMPU_M1 包括两个子系统： 

 Cortex-M1 内核子系统； 
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 AHB-Lite 扩展 AHB 总线和 APB 总线，及外设接口子系统。 

1.2.1 Cortex-M1 子系统 
处理器内核 

 ARM architecture v6-M Thumb 指令集架构，支持 16-bit Thumb 和 32-bit 
Thumb2 指令集； 

 可配置扩展操作系统； 

 系统异常处理； 

 中断异常处理和正常线程模式； 

 栈指针，正常是一个栈指针，扩展操作系统时两个栈指针； 

 大小端格式。 

- 可配置数据大小端格式 

- 指令和系统控制寄存器小端格式 

- 调试系统小端格式 

NVIC 

 可配置外部中断数量，1、8、16、32； 

 4 个优先级等级； 

 进入中断处理时自动保存处理器状态，中断处理结束时自动恢复状态。 

调试系统 

通过配置选项控制调试系统开关。 

 如果关闭调试系统，则 Cortex-M1 内核不支持调试系统 

 如果打开调试系统，则 Cortex-M1 内核支持调试系统 

- 可配置完整（full）模式和简化（reduced）模式 

 完整模式：4 个 BreakPoint Unit 和 2 个 Data Watchpoint； 
 简化模式：2 个 BreakPoint Unit 和 1 个 Data Watchpoint； 

- 可配置 DAP 端口 

 JTAG/SW 
 JTAG 
 SW 

Memory 

 ITCM：指令存储器 

- 可以选择内部指令存储器或外部指令存储器 

- 内部指令存储器可以配置 Size（1/2/4/8/16/32/64/128/256KB） 

- 内部指令存储器可以配置初始值 
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 DTCM：数据存储器 

- 可以选择内部数据存储器或外部数据存储器 

- 内部数据存储器可以配置 Size（1/2/4/8/16/32/64/128/256KB） 

32 位硬件乘法器 

 Normal 模式 

 Small 模式 

1.2.2 AHB-Lite Extension 子系统 
 AHB总线，及GPIO、CAN、Ethernet、DDR3 Memory、PSRAM、SPI-Flash、

AHB Master [1-6]； 

 APB 总线，及 UART0、UART1、Timer0、Timer1、Watch Dog、RTC、

DualTimer、TRNG、I2C Master、SPI Master、SD-Card、APB Master 
[1-16]。 

1.3 系统端口 
Gowin_EMPU_M1 系统端口定义，如表 1-1 所示。 

表 1-1 系统端口定义 
名称 I/O 位宽 描述 所属模块 
HCLK in 1 系统时钟 – 
hwRstn in 1 系统复位 – 
LOCKUP out 1 内核 Lockup 状态 – 
HALTED out 1 内核 Halt Debug 状态 Debug 
JTAG_3 inout 1 TRST 

Debug 

JTAG_4 inout 1 GND 
JTAG_5 inout 1 TDI 
JTAG_6 inout 1 GND 
JTAG_7 inout 1 TMS/SWDIO 
JTAG_8 inout 1 GND 
JTAG_9 inout 1 TCK/SWDCLK 
JTAG_10 inout 1 GND 
JTAG_11 inout 1 RTCK 
JTAG_12 inout 1 GND 
JTAG_13 inout 1 TDO/SWO 
JTAG_14 inout 1 GND 
JTAG_15 inout 1 RESET 
JTAG_16 inout 1 GND 
JTAG_17 inout 1 NC 
JTAG_18 inout 1 GND 
GPIO inout [15:0] GPIO 输入输出 GPIO I/O 
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名称 I/O 位宽 描述 所属模块 
GPIOIN in [15:0] GPIO 输入 

GPIO non-I/O GPIOOUT out [15:0] GPIO 输出 
GPIOOUTEN out [15:0] GPIO 输出使能 
UART0RXD in 1 UART0 接收 

UART0 
UART0TXD out 1 UART0 发送 
UART1RXD int 1 UART1 接收 

UART1 
UART1TXD out 1 UART1 发送 
TIMER0EXTIN in 1 Timer0 外部中断 Timer0 
TIMER1EXTIN in 1 Timer1 外部中断 Timer1 
RTCSRCCLK in 1 RTC 时钟源 32.768KHz RTC 
SCL inout 1 串行时钟 

I2C I/O 
SDA inout 1 串行数据 
SCLIN in 1 串行时钟输入 

I2C non-I/O 

SCLOUT out 1 串行时钟输出 
SCLOUTEN out 1 串行时钟输出使能 
SDAIN in 1 串行数据输入 
SDAOUT out 1 串行数据输出 
SDAOUTEN out 1 串行数据输出使能 
MOSI out 1 主设备输出/从设备输入 

SPI 
MISO in 1 主设备输入/从设备输出 
SCLK out 1 时钟信号 
NSS out 1 从设备选择信号 
SD_SPICLK in 1 SPI 时钟信号 

SD-Card 

SD_CLK out 1 SD 时钟信号 
SD_CS out 1 片选信号 
SD_DATAIN in 1 数据输入 
SD_DATAOUT out 1 数据输出 
SD_CARD_INIT out 1 初始化”0” 
SD_CHECKIN in 1 输入检查 
SD_CHECKOUT out 1 输出检查 
CAN_RX in 1 数据输入 

CAN 
CAN_TX out 1 数据输出 
RGMII_TXC out 1 RGMII 发送时钟 

Ethernet RGMII 
Interface 

RGMII_TX_CTL out 1 RGMII 发送控制 
RGMII_TXD out [3:0] RGMII 发送数据 
RGMII_RXC in 1 RGMII 接收时钟 
RGMII_RX_CTL in 10 RGMII 接收控制 
RGMII_RXD in [3:0] RGMII 接收数据 
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名称 I/O 位宽 描述 所属模块 
GTX_CLK in 1 RGMII 125MHz 时钟输入 
GMII_RX_CLK in 1 GMII 接收时钟 

Ethernet GMII 
Interface 

GMII_RX_DV in 1 GMII 接收使能 
GMII_RXD in [7:0] GMII 接收数据 
GMII_RX_ER in 1 GMII 接收错误 
GTX_CLK in 1 GMII 125MHz 时钟输入 
GMII_GTX_CLK out 1 GMII 发送时钟 
GMII_TXD out [7:0] GMII 发送数据 
GMII_TX_EN out 1 GMII 发送使能 
GMII_TX_ER out 1 GMII 发送错误 
MII_RX_CLK in 1 MII 接收时钟 

Ethernet MII 
Interface 

MII_RXD in [3:0] MII 接收数据 
MII_RX_DV in 1 MII 接收使能 
MII_RX_ER in 1 MII 接收错误 
MII_TX_CLK in 1 MII 发送时钟 
MII_TXD out [3:0] MII 发送数据 
MII_TX_EN out 1 MII 发送使能 
MII_TX_ER out 1 MII 发送错误 
MII_COL in 1 MII 冲突信号 
MII_CRS in 1 MII 载波信号 
MDC out 1 管理通道时钟 

Ethernet 
MDIO inout 1 管理通道数据 
DDR_CLK_I in 1 50MHz 时钟输入 

DDR3 

DDR_INIT_COMPLETE_O out 1 初始化完成信号 
DDR_ADDR_O out [15:0] Row 地址、Column 地址 
DDR_BA_O out [2:0] Bank 地址 
DDR_CS_N_O out 1 片选信号 
DDR_RAS_N_O out 1 Row 地址选通信号 
DDR_CAS_N_O out 1 Column 地址选通信号 
DDR_WE_N_O out 1 Row 写使能 

DDR_CLK_O out 1 提供给DDR3 SDRAM的时钟信

号 
DDR_CLK_N_O out 1 与 DDR_CLK_O 组成差分信号 
DDR_CKE_O out 1 DDR3 SDRAM 时钟使能信号 
DDR_ODT_O out 1 内存信号端接电阻控制 
DDR_RESET_N_O out 1 DDR3 SDRAM 复位信号 
DDR_DQM_O out [1:0] DDR3 SDRAM 数据屏蔽信号 
DDR_DQ_IO inout [15:0] DDR3 SDRAM 数据 
DDR_DQS_IO inout [1:0] DDR3 SDRAM 数据选通信号 
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名称 I/O 位宽 描述 所属模块 
DDR_DQS_N_IO inout [1:0] 与 DDR_DQS_IO 组成差分信号 
O_psram_ck out [1:0] 提供给 PSRAM 的时钟信号 

PSRAM 

O_psram_ck_n out [1:0] 与 O_psram_ck 组成差分信号 

IO_psram_rwds inout [1:0] PSRAM 数据选通信号及掩码信

号 
IO_psram_dq inout [15:0] PSRAM 数据 
O_psram_reset_n out [1:0] PSRAM 复位信号 
O_psram_cs_n out [1:0] 片选，低有效 
init_calib out 1 初始化完成信号 

psram_ref_clk in 1 参考输入时钟，一般为板载晶振

时钟 

psram_memory_clk in 1 
用户输入颗粒工作时钟，一般为

PLL 倍频出来的高速时钟，也可

以不使用 PLL 
FLASH_SPI_HOLDN inout 1 NC 

SPI-Flash 

FLASH_SPI_CSN inout 1 从设备选择信号 
FLASH_SPI_MISO inout 1 主设备输入/从设备输出 
FLASH_SPI_MOSI inout 1 主设备输出/从设备输入 
FLASH_SPI_WPN inout 1 NC 
FLASH_SPI_CLK inout 1 时钟信号 
APB1PSTRB out [3:0] APB1 PSTRB 

APB1 Master [1] 

APB1PPROT out [2:0] APB1 PPROT 
APB1PSEL out 1 APB1 PSEL 
APB1PENABLE out 1 APB1 PENABLE 
APB1PADDR out [31:0] APB1 PADDR 
APB1PWRITE out 1 APB1 PWRITE 
APB1PWDATA out [31:0] APB1 PWDATA 
APB1PRDATA in [31:0] APB1 PRDATA 
APB1PREADY in 1 APB1 PREADY 
APB1PSLVERR in 1 APB1 PSLVERR 
APB1PCLK out 1 APB1 PCLK 
APB1PRESET out 1 APB1 RESET 
APB2PSTRB out [3:0] APB2 PSTRB 

APB Master [2] 

APB2PPROT out [2:0] APB2 PPROT 
APB2PSEL out 1 APB2 PSEL 
APB2PENABLE out 1 APB2 PENABLE 
APB2PADDR out [31:0] APB2 PADDR 
APB2PWRITE out 1 APB2 PWRITE 
APB2PWDATA out [31:0] APB2 PWDATA 
APB2PRDATA in [31:0] APB2 PRDATA 
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名称 I/O 位宽 描述 所属模块 
APB2PREADY in 1 APB2 PREADY 
APB2PSLVERR in 1 APB2 PSLVERR 
APB2PCLK out 1 APB2 PCLK 
APB2PRESET out 1 APB2 RESET 
APB3PSTRB out [3:0] APB3 PSTRB 

APB Master [3] 

APB3PPROT out [2:0] APB3 PPROT 
APB3PSEL out 1 APB3 PSEL 
APB3PENABLE out 1 APB3 PENABLE 
APB3PADDR out [31:0] APB3 PADDR 
APB3PWRITE out 1 APB3 PWRITE 
APB3PWDATA out [31:0] APB3 PWDATA 
APB3PRDATA in [31:0] APB3 PRDATA 
APB3PREADY in 1 APB3 PREADY 
APB3PSLVERR in 1 APB3 PSLVERR 
APB3PCLK out 1 APB3 PCLK 
APB3PRESET out 1 APB3 RESET 
APB4PSTRB out [3:0] APB4 PSTRB 

APB Master [4] 

APB4PPROT out [2:0] APB4 PPROT 
APB4PSEL out 1 APB4 PSEL 
APB4PENABLE out 1 APB4 PENABLE 
APB4PADDR out [31:0] APB4 PADDR 
APB4PWRITE out 1 APB4 PWRITE 
APB4PWDATA out [31:0] APB4 PWDATA 
APB4PRDATA in [31:0] APB4 PRDATA 
APB4PREADY in 1 APB4 PREADY 
APB4PSLVERR in 1 APB4 PSLVERR 
APB4PCLK out 1 APB4 PCLK 
APB4PRESET out 1 APB4 RESET 
APB5PSTRB out [3:0] APB5 PSTRB 

APB Master [5] 

APB5PPROT out [2:0] APB5 PPROT 
APB5PSEL out 1 APB5 PSEL 
APB5PENABLE out 1 APB5 PENABLE 
APB5PADDR out [31:0] APB5 PADDR 
APB5PWRITE out 1 APB5 PWRITE 
APB5PWDATA out [31:0] APB5 PWDATA 
APB5PRDATA in [31:0] APB5 PRDATA 
APB5PREADY in 1 APB5 PREADY 
APB5PSLVERR in 1 APB5 PSLVERR 
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名称 I/O 位宽 描述 所属模块 
APB5PCLK out 1 APB5 PCLK 
APB5PRESET out 1 APB5 RESET 
APB6PSTRB out [3:0] APB6 PSTRB 

APB Master [6] 

APB6PPROT out [2:0] APB6 PPROT 
APB6PSEL out 1 APB6 PSEL 
APB6PENABLE out 1 APB6 PENABLE 
APB6PADDR out [31:0] APB6 PADDR 
APB6PWRITE out 1 APB6 PWRITE 
APB6PWDATA out [31:0] APB6 PWDATA 
APB6PRDATA in [31:0] APB6 PRDATA 
APB6PREADY in 1 APB6 PREADY 
APB6PSLVERR in 1 APB6 PSLVERR 
APB6PCLK out 1 APB6 PCLK 
APB6PRESET out 1 APB6 RESET 
APB7PSTRB out [3:0] APB7 PSTRB 

APB Master [7] 

APB7PPROT out [2:0] APB7 PPROT 
APB7PSEL out 1 APB7 PSEL 
APB7PENABLE out 1 APB7 PENABLE 
APB7PADDR out [31:0] APB7 PADDR 
APB7PWRITE out 1 APB7 PWRITE 
APB7PWDATA out [31:0] APB7 PWDATA 
APB7PRDATA in [31:0] APB7 PRDATA 
APB7PREADY in 1 APB7 PREADY 
APB7PSLVERR in 1 APB7 PSLVERR 
APB7PCLK out 1 APB7 PCLK 
APB7PRESET out 1 APB7 RESET 
APB8PSTRB out [3:0] APB8 PSTRB 

APB Master [8] 

APB8PPROT out [2:0] APB8 PPROT 
APB8PSEL out 1 APB8 PSEL 
APB8PENABLE out 1 APB8 PENABLE 
APB8PADDR out [31:0] APB8 PADDR 
APB8PWRITE out 1 APB8 PWRITE 
APB8PWDATA out [31:0] APB8 PWDATA 
APB8PRDATA in [31:0] APB8 PRDATA 
APB8PREADY in 1 APB8 PREADY 
APB8PSLVERR in 1 APB8 PSLVERR 
APB8PCLK out 1 APB8 PCLK 
APB8PRESET out 1 APB8 RESET 
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名称 I/O 位宽 描述 所属模块 
APB9PSTRB out [3:0] APB9 PSTRB 

APB Master [9] 

APB9PPROT out [2:0] APB9 PPROT 
APB9PSEL out 1 APB9 PSEL 
APB9PENABLE out 1 APB9 PENABLE 
APB9PADDR out [31:0] APB9 PADDR 
APB9PWRITE out 1 APB9 PWRITE 
APB9PWDATA out [31:0] APB9 PWDATA 
APB9PRDATA in [31:0] APB9 PRDATA 
APB9PREADY in 1 APB9 PREADY 
APB9PSLVERR in 1 APB9 PSLVERR 
APB9PCLK out 1 APB9 PCLK 
APB9PRESET out 1 APB9 RESET 
APB10PSTRB out [3:0] APB10 PSTRB 

APB Master [10] 

APB10PPROT out [2:0] APB10 PPROT 
APB10PSEL out 1 APB10 PSEL 
APB10PENABLE out 1 APB10 PENABLE 
APB10PADDR out [31:0] APB10 PADDR 
APB10PWRITE out 1 APB10 PWRITE 
APB10PWDATA out [31:0] APB10 PWDATA 
APB10PRDATA in [31:0] APB10 PRDATA 
APB10PREADY in 1 APB10 PREADY 
APB10PSLVERR in 1 APB10 PSLVERR 
APB10PCLK out 1 APB10 PCLK 
APB10PRESET out 1 APB10 RESET 
APB11PSTRB out [3:0] APB11 PSTRB 

APB Master [11] 

APB11PPROT out [2:0] APB11 PPROT 
APB11PSEL out 1 APB11 PSEL 
APB11PENABLE out 1 APB11 PENABLE 
APB11PADDR out [31:0] APB11 PADDR 
APB11PWRITE out 1 APB11 PWRITE 
APB11PWDATA out [31:0] APB11 PWDATA 
APB11PRDATA in [31:0] APB11 PRDATA 
APB11PREADY in 1 APB11 PREADY 
APB11PSLVERR in 1 APB11 PSLVERR 
APB11PCLK out 1 APB11 PCLK 
APB11PRESET out 1 APB11 RESET 
APB12PSTRB out [3:0] APB12 PSTRB 

APB Master [12] 
APB12PPROT out [2:0] APB12 PPROT 



1 硬件架构 1.3 系统端口 

 

IPUG531-1.6 10(57) 

 

名称 I/O 位宽 描述 所属模块 
APB12PSEL out 1 APB12 PSEL 
APB12PENABLE out 1 APB12 PENABLE 
APB12PADDR out [31:0] APB12 PADDR 
APB12PWRITE out 1 APB12 PWRITE 
APB12PWDATA out [31:0] APB12 PWDATA 
APB12PRDATA in [31:0] APB12 PRDATA 
APB12PREADY in 1 APB12 PREADY 
APB12PSLVERR in 1 APB12 PSLVERR 
APB12PCLK out 1 APB12 PCLK 
APB12PRESET out 1 APB12 RESET 
APB13PSTRB out [3:0] APB13 PSTRB 

APB Master [13] 

APB13PPROT out [2:0] APB13 PPROT 
APB13PSEL out 1 APB13 PSEL 
APB13PENABLE out 1 APB13 PENABLE 
APB13PADDR out [31:0] APB13 PADDR 
APB13PWRITE out 1 APB13 PWRITE 
APB13PWDATA out [31:0] APB13 PWDATA 
APB13PRDATA in [31:0] APB13 PRDATA 
APB13PREADY in 1 APB13 PREADY 
APB13PSLVERR in 1 APB13 PSLVERR 
APB13PCLK out 1 APB13 PCLK 
APB13PRESET out 1 APB13 RESET 
APB14PSTRB out [3:0] APB14 PSTRB 

APB Master [14] 

APB14PPROT out [2:0] APB14 PPROT 
APB14PSEL out 1 APB14 PSEL 
APB14PENABLE out 1 APB14 PENABLE 
APB14PADDR out [31:0] APB14 PADDR 
APB14PWRITE out 1 APB14 PWRITE 
APB14PWDATA out [31:0] APB14 PWDATA 
APB14PRDATA in [31:0] APB14 PRDATA 
APB14PREADY in 1 APB14 PREADY 
APB14PSLVERR in 1 APB14 PSLVERR 
APB14PCLK out 1 APB14 PCLK 
APB14PRESET out 1 APB14 RESET 
APB15PSTRB out [3:0] APB15 PSTRB 

APB Master [15] 
APB15PPROT out [2:0] APB15 PPROT 
APB15PSEL out 1 APB15 PSEL 
APB15PENABLE out 1 APB15 PENABLE 
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名称 I/O 位宽 描述 所属模块 
APB15PADDR out [31:0] APB15 PADDR 
APB15PWRITE out 1 APB15 PWRITE 
APB15PWDATA out [31:0] APB15 PWDATA 
APB15PRDATA in [31:0] APB15 PRDATA 
APB15PREADY in 1 APB15 PREADY 
APB15PSLVERR in 1 APB15 PSLVERR 
APB15PCLK out 1 APB15 PCLK 
APB15PRESET out 1 APB15 RESET 
APB16PSTRB out [3:0] APB16 PSTRB 

APB Master [16] 

APB16PPROT out [2:0] APB16 PPROT 
APB16PSEL out 1 APB16 PSEL 
APB16PENABLE out 1 APB16 PENABLE 
APB16PADDR out [31:0] APB16 PADDR 
APB16PWRITE out 1 APB16 PWRITE 
APB16PWDATA out [31:0] APB16 PWDATA 
APB16PRDATA in [31:0] APB16 PRDATA 
APB16PREADY in 1 APB16 PREADY 
APB16PSLVERR in 1 APB16 PSLVERR 
APB16PCLK out 1 APB16 PCLK 
APB16PRESET out 1 APB16 RESET 
EXTFLASH0HSEL out 1 External Flash HSEL 

External 
Instruction 
Memory 

EXTFLASH0HADDR out [31:0] External Flash HADDR 
EXTFLASH0HTRANS out [1:0] External Flash HTRANS 
EXTFLASH0HWRITE out 1 External Flash HWRITE 
EXTFLASH0HSIZE out [2:0] External Flash HSIZE 
EXTFLASH0HBURST out [2:0] External Flash HBURST 
EXTFLASH0HPROT out [3:0] External Flash HPROT 
EXTFLASH0HWDATA out [31:0] External Flash HWDATA 
EXTFLASH0HMASTLOCK out 1 External Flash HMASTLOCK 
EXTFLASH0HREADYMUX out 1 External Flash HREADYMUX 
EXTFLASH0HRDATA in [31:0] External Flash HRDATA 
EXTFLASH0HREADYOUT in 1 External Flash HREDAYOUT 
EXTFLASH0HRESP in [1:0] External Flash HRESP 
EXTFLASH0HMASTER out [3:0] External Flash MASTER 
EXTFLASH0HCLK out 1 External Flash HCLK 
EXTFLASH0HRESET out 1 External Flash RESET 
EXTSRAM0HSEL out 1 External SRAM HSEL External Data 

Memory EXTSRAM0HADDR out [31:0] External SRAM HADDR 
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名称 I/O 位宽 描述 所属模块 
EXTSRAM0HTRANS out [1:0] External SRAM HTRANS 
EXTSRAM0HWRITE out 1 External SRAM HWRITE 
EXTSRAM0HSIZE out [2:0] External SRAM HSIZE 
EXTSRAM0HBURST out [2:0] External SRAM HBURST 
EXTSRAM0HPROT out [3:0] External SRAM HPROT 
EXTSRAM0HWDATA out [31:0] External SRAM HWDATA 
EXTSRAM0HMASTLOCK out 1 External SRAM HMASTLOCK 
EXTSRAM0HREADYMUX out 1 External SRAM HREADYMUX 
EXTSRAM0HRDATA in [31:0] External SRAM HRDATA 
EXTSRAM0HREADYOUT in 1 External SRAM HREDAYOUT 
EXTSRAM0HRESP in [1:0] External SRAM HRESP 
EXTSRAM0HMASTER out [3:0] External SRAM MASTER 
EXTSRAM0HCLK out 1 External SRAM HCLK 
EXTSRAM0HRESET out 1 External SRAM RESET 
AHB1HSEL out 1 AHB1 HSEL 

AHB Master [1] 

AHB1HADDR out [31:0] AHB1 HADDR 
AHB1HTRANS out [1:0] AHB1 HTRANS 
AHB1HWRITE out 1 AHB1 HWRITE 
AHB1HSIZE out [2:0] AHB1 HSIZE 
AHB1HBURST out [2:0] AHB1 HBURST 
AHB1HPROT out [3:0] AHB1 HPROT 
AHB1HWDATA out [31:0] AHB1 HWDATA 
AHB1HMASTLOCK out 1 AHB1 HMASTLOCK 
AHB1HREADYMUX out 1 AHB1 HREADYMUX 
AHB1HRDATA in [31:0] AHB1 HRDATA 
AHB1HREADYOUT in 1 AHB1 HREDAYOUT 
AHB1HRESP in [1:0] AHB1 HRESP 
AHB1HMASTER out [3:0] AHB1 MASTER 
AHB1HCLK out 1 AHB1 HCLK 
AHB1HRESET out 1 AHB1 RESET 
AHB2HSEL out 1 AHB2 HSEL 

AHB Master [2] 

AHB2HADDR out [31:0] AHB2 HADDR 
AHB2HTRANS out [1:0] AHB2 HTRANS 
AHB2HWRITE out 1 AHB2 HWRITE 
AHB2HSIZE out [2:0] AHB2 HSIZE 
AHB2HBURST out [2:0] AHB2 HBURST 
AHB2HPROT out [3:0] AHB2 HPROT 
AHB2HWDATA out [31:0] AHB2 HWDATA 
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名称 I/O 位宽 描述 所属模块 
AHB2HMASTLOCK out 1 AHB2 HMASTLOCK 
AHB2HREADYMUX out 1 AHB2 HREADYMUX 
AHB2HRDATA in [31:0] AHB2 HRDATA 
AHB2HREADYOUT in 1 AHB2 HREDAYOUT 
AHB2HRESP in [1:0] AHB2 HRESP 
AHB2HMASTER out [3:0] AHB2 MASTER 
AHB2HCLK out 1 AHB2 HCLK 
AHB2HRESET out 1 AHB2 RESET 
AHB3HSEL out 1 AHB3 HSEL 

AHB Master [3] 

AHB3HADDR out [31:0] AHB3 HADDR 
AHB3HTRANS out [1:0] AHB3 HTRANS 
AHB3HWRITE out 1 AHB3 HWRITE 
AHB3HSIZE out [2:0] AHB3 HSIZE 
AHB3HBURST out [2:0] AHB3 HBURST 
AHB3HPROT out [3:0] AHB3 HPROT 
AHB3HWDATA out [31:0] AHB3 HWDATA 
AHB3HMASTLOCK out 1 AHB3 HMASTLOCK 
AHB3HREADYMUX out 1 AHB3 HREADYMUX 
AHB3HRDATA in [31:0] AHB3 HRDATA 
AHB3HREADYOUT in 1 AHB3 HREDAYOUT 
AHB3HRESP in [1:0] AHB3 HRESP 
AHB3HMASTER out [3:0] AHB3 MASTER 
AHB3HCLK out 1 AHB3 HCLK 
AHB3HRESET out 1 AHB3 RESET 
AHB4HSEL out 1 AHB4 HSEL 

AHB Master [4] 

AHB4HADDR out [31:0] AHB4 HADDR 
AHB4HTRANS out [1:0] AHB4 HTRANS 
AHB4HWRITE out 1 AHB4 HWRITE 
AHB4HSIZE out [2:0] AHB4 HSIZE 
AHB4HBURST out [2:0] AHB4 HBURST 
AHB4HPROT out [3:0] AHB4 HPROT 
AHB4HWDATA out [31:0] AHB4 HWDATA 
AHB4HMASTLOCK out 1 AHB4 HMASTLOCK 
AHB4HREADYMUX out 1 AHB4 HREADYMUX 
AHB4HRDATA in [31:0] AHB4 HRDATA 
AHB4HREADYOUT in 1 AHB4 HREDAYOUT 
AHB4HRESP in [1:0] AHB4 HRESP 
AHB4HMASTER out [3:0] AHB4 MASTER 



1 硬件架构 1.3 系统端口 

 

IPUG531-1.6 14(57) 

 

名称 I/O 位宽 描述 所属模块 
AHB4HCLK out 1 AHB4 HCLK 
AHB4HRESET out 1 AHB4 RESET 
AHB5HSEL out 1 AHB5 HSEL 

AHB Master [5] 

AHB5HADDR out [31:0] AHB5 HADDR 
AHB5HTRANS out [1:0] AHB5 HTRANS 
AHB5HWRITE out 1 AHB5 HWRITE 
AHB5HSIZE out [2:0] AHB5 HSIZE 
AHB5HBURST out [2:0] AHB5 HBURST 
AHB5HPROT out [3:0] AHB5 HPROT 
AHB5HWDATA out [31:0] AHB5 HWDATA 
AHB5HMASTLOCK out 1 AHB5 HMASTLOCK 
AHB5HREADYMUX out 1 AHB5 HREADYMUX 
AHB5HRDATA in [31:0] AHB5 HRDATA 
AHB5HREADYOUT in 1 AHB5 HREDAYOUT 
AHB5HRESP in [1:0] AHB5 HRESP 
AHB5HMASTER out [3:0] AHB5 MASTER 
AHB5HCLK out 1 AHB5 HCLK 
AHB5HRESET out 1 AHB5 RESET 
AHB6HSEL out 1 AHB6 HSEL 

AHB Master [6] 

AHB6HADDR out [31:0] AHB6 HADDR 
AHB6HTRANS out [1:0] AHB6 HTRANS 
AHB6HWRITE out 1 AHB6 HWRITE 
AHB6HSIZE out [2:0] AHB6 HSIZE 
AHB6HBURST out [2:0] AHB6 HBURST 
AHB6HPROT out [3:0] AHB6 HPROT 
AHB6HWDATA out [31:0] AHB6 HWDATA 
AHB6HMASTLOCK out 1 AHB6 HMASTLOCK 
AHB6HREADYMUX out 1 AHB6 HREADYMUX 
AHB6HRDATA in [31:0] AHB6 HRDATA 
AHB6HREADYOUT in 1 AHB6 HREDAYOUT 
AHB6HRESP in [1:0] AHB6 HRESP 
AHB6HMASTER out [3:0] AHB6 MASTER 
AHB6HCLK out 1 AHB6 HCLK 
AHB6HRESET out 1 AHB6 RESET 
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1.4 系统资源统计 
Gowin_EMPU_M1 系统资源统计，如表 1-2 所示。 

表 1-2 系统资源统计 

Resources 
Configuration LUTs Registers BSRAMs DSP 

Macros 

Cortex-M1 Minimum and No Peripherals 3034 1046 8 0 
Cortex-M1 Default and No Peripherals 5237 2322 32 2 
Cortex-M1 Default and Peripherals 
(GPIO/UART/Timer/WatchDog) 6961 3103 32 2 

Cortex-M1 Default and All Peripherals 21029 12929 48 2 
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2 硬件设计流程 

2.1 硬件环境 
 DK-START-GW2A18 V2.0 

GW2A-LV18PG256C8/I7 
 DK-START-GW1N9 V1.1 

GW1N-LV9LQ144C6/I5 
 DK-START-GW2A55 V1.3 

GW2A-LV55PG484C8/I7 
 DK-START-GW2AR18 V1.1 

GW2AR-LV18ELQ144PC6/I5 

2.2 软件环境 
Gowin_V1.9.6 Beta 及以上版本。 

2.3 IP Core Generator 工具 
高云云源软件提供 IP Core Generator 工具，用于配置和产生

Gowin_EMPU_M1 硬件设计。 

IP Core Generator 工具的使用方法，请参考 SUG284，Gowin IP Core 
Generator 用户指南。 

2.4 下载工具 
高云云源软件提供下载工具 Programmer，用于下载硬件设计码流文件。 

下载工具 Programmer 的使用方法，请参考 SUG502，Gowin 
Programmer 用户指南。 

2.5 设计流程 
Gowin_EMPU_M1 硬件设计流程： 

1. IP Core Generator工具配置Cortex-M1、APB Bus Peripherals和AHB 
Bus Peripherals，产生 Gowin_EMPU_M1 硬件设计，导入工程； 

http://cdn.gowinsemi.com.cn/SUG284.pdf
http://cdn.gowinsemi.com.cn/SUG502.pdf
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2. 实例化 Gowin_EMPU_M1 Top Module，导入用户设计，连接用户设

计与 Gowin_EMPU_M1 Top Module； 
3. 物理约束和时序约束； 
4. 使用综合工具 Synplify Pro 或 GowinSynthesis 综合； 
5. 使用布局布线工具Place & Route布局布线，产生硬件设计码流文件； 
6. 使用下载工具 Programmer，下载硬件设计码流到
GW1N-9/GW1NR-9/GW1N-9C/GW1NR-9C/GW2A-18/GW2A-18C/G
W2AR-18/GW2AR-18C/GW2ANR-18C/GW2A-55/GW2A-55C。 
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3 工程模板 

3.1 工程创建 
3.1.1 新建工程 

双击打开高云云源软件，选择菜单栏“File > New… > FPGA Design 
Project”，创建 FPGA Design 工程，如图 3-1 所示。 
图 3-1 新建 FPGA Design 工程 
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3.1.2 设定工程名称和路径 
输入工程名称，选择工程路径，如图 3-2 所示。 

图 3-2 设定工程名称和路径 

 

3.1.3 选择器件 
选择 Series、Device、Package、Speed 和 Part Number，如图 3-3 所

示。 

以软件开发工具包 DK-START-GW2A18 V2.0 开发板参考设计为例，如

下所示。 

 Series：GW2A 

 Device：GW2A-18 

 Package：PBGA256 

 Speed：C8/I7 

 Part Number：GW2A-LV18PG256C8/I7 
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图 3-3 选择器件 

 

3.1.4 完成工程创建 
如图 3-4 所示，完成新建工程。 

图 3-4 完成工程创建 
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3.2 硬件设计 
使用 IP Core Generator 工具，产生 Gowin_EMPU_M1 硬件设计。 

选择菜单栏“Tools > IP Core Generator”或工具栏 IP Core Generator
“ ”，打开 IP Core Generator。 

选择“Soft IP Core > Microprocessor System > Soft-Core-MCU > 
Gowin_EMPU_M1 1.6”，如图 3-5 所示。 
图 3-5 选择 Gowin_EMPU_M1 
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打开 Gowin_EMPU_M1，Gowin_EMPU_M1 系统配置，如图 3-6 所示，

包括 Cortex-M1、APB Bus Peripherals 和 AHB Bus Peripherals 配置选项。 
图 3-6 系统配置 
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3.2.1 Cortex-M1 硬件设计 
Cortex-M1 硬件设计配置选项，如表 3-1 所示。 

表 3-1 Cortex-M1 配置选项 
配置选项 描述 
Number of interrupts 配置 Cortex-M1 外部中断数量，可选择 1 或 8 或 16 或 32，默认为 32。 
OS Extension 配置 Cortex-M1 是否支持操作系统，默认为支持。 
Small Multiplier 配置 Cortex-M1 small 模式硬件乘法器，默认为 normal 模式。 
Big Endian 配置 Cortex-M1 数据大端格式，默认为小端格式。 
Enable Debug 使能 Cortex-M1 Debug 功能，默认为使能 Debug。 

Debug Port Select 配置调试器接口，可以选择 JTAG 或 Serial Wire 或 JTAG and Serial Wire，
默认为 JTAG and Serial Wire。 

Small Debug 配置 Small 模式调试器，默认为 Full 模式调试器。 
ITCM Select 选择内部或外部指令存储器，默认为内部指令存储器。 

ITCM Size 

配置内部指令存储器 Size，可以选择 1/2/4/8/16/32/64/128/256KB。 
 GW1N-9/GW1NR-9/GW1N-9C/GW1NR-9C 最大选择 32KB，默认为

16KB； 
 GW2A-18/GW2A-18C/GW2AR-18/GW2AR-18C/GW2ANR-18C 最大

选择 64KB，默认为 32KB； 
 GW2A-55/GW2A-55C 最大选择 256KB，默认为 64KB。 

Initialize ITCM 使能 ITCM 初始化，默认为禁用。 
ITCM Initialization Path ITCM 初始值文件路径。 
DTCM Select 选择内部或外部数据存储器，默认为内部数据存储器 

DTCM Size 

配置内部数据存储器 Size，可以选择 1/2/4/8/16/32/64/128/256KB。 
 GW1N-9/GW1NR-9/GW1N-9C/GW1NR-9C 最大选择 32KB，默认为

16KB； 
 GW2A-18/GW2A-18C/GW2AR-18/GW2AR-18C/GW2ANR-18C 最大

选择 64KB，默认为 32KB； 
 GW2A-55/GW2A-55C 最大选择 256KB，默认为 64KB。 
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双击 Cortex-M1，打开 Cortex-M1 的配置选项，如图 3-7 所示，包括通

用配置、调试配置和存储配置。 
图 3-7 Cortex-M1 配置选项 
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通用配置 

选择通用配置选项，如图 3-8 所示，可以配置中断数量、操作系统扩展、

乘法器模式和数据存储格式。 
图 3-8 Cortex-M1 通用配置 

 
 

 中断数量配置 
可以选择 1 或 8 或 16 或 32，可以配置 1 个或 8 个或 16 个或 32 个外部

中断，默认为 32 个。 

 操作系统扩展配置 
如果选择，则 Cortex-M1 扩展支持操作系统，默认为支持操作系统扩展。 

 乘法器模式配置 
如果选择，则 Cortex-M1 支持 Small 乘法器，否则支持 Normal 乘法器，

默认为 Normal 乘法器。 

 数据存储格式配置 
如果选择，则 Cortex-M1 支持数据大端格式，否则支持数据小端格式，

默认为小端格式。 
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调试配置 

选择调试配置选项，如图 3-9 所示，可以配置使能调试、调试接口和调

试器模式。 
图 3-9 Cortex-M1 调试配置 

 
 

 Enable Debug 
如果选择 Enable Debug，Cortex-M1 支持调试功能，否则 Cortex-M1 不

支持调试功能，默认为使能 Debug。 

 调试接口配置 
可以选择 JTAG 或 Serial Wire 或 JTAG and Serial Wire，默认为 JTAG 
and Serial Wire。 

 调试器模式配置 
如果选择 Small Debug，则 Cortex-M1 支持 Small 模式调试器，否则支

持 Full 模式调试器，默认为 Full 模式调试器。 
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存储配置 

选择存储配置选项，如图 3-10 所示，可以配置 ITCM 和 DTCM。 
图 3-10 Cortex-M1 存储配置 

 
 

 ITCM Select 配置 

- 可以选择 Internal Instruction Memory 或 External Instruction 
Memory； 

- 默认 Internal Instruction Memory； 

- Internal Instruction Memory：内部指令存储器，片内 Block RAM 硬

件存储资源，起始地址 0x00000000； 

- External Instruction Memory：外部指令存储器，如 DDR3/Flash，
起始地址 0x00000000。 

 ITCM Size 配置 

- 前提条件：已选择 Internal Instruction Memory； 

- 可以选择 1KB 或 2KB 或 4KB 或 8KB 或 16KB 或 32KB 或 64KB 或

128KB 或 256KB； 

- GW1N-9/GW1NR-9/GW1N-9C/GW1NR-9C，ITCM Size 最大选择

为 32KB，默认为 16KB； 
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- GW2A-18/GW2A-18C/GW2AR-18/GW2AR-18C/GW2ANR-18C，

ITCM Size 最大选择为 64KB，默认为 32KB； 

- GW2A-55/GW2A-55C，ITCM Size 最大选择为 256KB，默认为 64KB。 

 ITCM Initialization 配置 

- 前提条件：已选择 Internal Instruction Memory； 

- 如果选择 Initialize ITCM，则支持 ITCM 初始化，可以在 ITCM 
Initialization Path 导入 ITCM 初始值文件路径； 

- 如果选择使用片外 SPI-Flash 下载启动方式，ITCM 初始值根据不同

的 ITCM Size 导入不同的 bootload 文件路径。 
注！ 

ITCM Initialization Path 导入的路径，不能有以数字命名的文件夹路径。 

 DTCM Select 配置 

- 可以选择 Internal Data Memory 或 External Data Memory； 

- 默认 Internal Data Memory； 

- Internal Data Memory：内部数据存储器，片内 Block RAM 硬件存

储资源，起始地址 0x20000000； 

- External Data Memory：外部数据存储器，如 DDR3，起始地址

0x20100000。 

 DTCM Size 配置 

- 前提条件：已选择 Internal Data Memory； 

- 可以选择 1KB 或 2KB 或 4KB 或 8KB 或 16KB 或 32KB 或 64KB 或

128KB 或 256KB； 

- GW1N-9/GW1NR-9/GW1N-9C/GW1NR-9C，DTCM Size 最大选择

为 32KB，默认为 16KB； 

- GW2A-18/GW2A-18C/GW2AR-18/GW2AR-18C/GW2ANR-18C，

DTCM Size 最大选择为 64KB，默认为 32KB； 

- GW2A-55/GW2A-55C，DTCM Size 最大选择为 256KB，默认为

64KB。 

 ITCM 与 DTCM Size 配置限制 

- 前提条件：已选择 Internal Instruction Memory 和 Internal Data 
Memory； 

- GW1N-9/GW1NR-9/GW1N-9C/GW1NR-9C，ITCM 或 DTCM 最大

可配置为 32KB，如果 ITCM 或 DTCM 某个存储器已配置为 32KB，
则另一个存储器最大只能配置为 16KB； 

- GW2A-18/GW2A-18C/GW2AR-18/GW2AR-18C/GW2ANR-18C，

ITCM 或 DTCM 最大可配置为 64KB，如果 ITCM 或 DTCM 某个存
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储器已配置为 64KB，则另一个存储器最大只能配置为 16KB； 

- GW2A-55/GW2A-55C，ITCM 或 DTCM 最大可配置为 256KB，如

果 ITCM 或 DTCM 某个存储器已配置为 256KB，则另一个存储器最

大只能配置为 16KB。 

3.2.2 AHB-Lite Extension 硬件设计 
AHB-Lite Extension 配置选项如表 3-2 所示。 

表 3-2 AHB-Lite Extension 配置选项 
配置选项 描述 
Enable GPIO 使能 GPIO，默认关闭。 
Enable GPIO I/O 使能 GPIO inout 端口类型，默认使能。 
Enable CAN 使能 CAN，默认关闭。 
Buffer Depth CAN 选择 Buffer Depth，默认值为 256。 
Enable Ethernet 使能 Ethernet，默认关闭。 

Interface Ethernet 选择 Interface (RGMII/GMII/MII)，默认为

RGMII。 
RGMII Input Delay RGMII input delay，默认值为 100。 
MIIM Clock Divider MIIM clock divider，默认值为 20。 
Enable DDR3 使能 DDR3 Memory，默认关闭。 
Enable PSRAM 使能 PSRAM，默认关闭。 

Enable SPI-Flash 使能 SPI-Flash 下载功能和 Memory 读、写、擦除功能，

默认关闭。 
Enable AHB Master [1] 使能 AHB Master [1]，默认关闭。 
Enable AHB Master [2] 使能 AHB Master [2]，默认关闭。 
Enable AHB Master [3] 使能 AHB Master [3]，默认关闭。 
Enable AHB Master [4] 使能 AHB Master [4]，默认关闭。 
Enable AHB Master [5] 使能 AHB Master [5]，默认关闭。 
Enable AHB Master [6] 使能 AHB Master [6]，默认关闭。 
Enable UART0 使能串口 0，默认关闭。 
Enable UART1 使能串口 1，默认关闭。 
Enable Timer0 使能定时器 0，默认关闭。 
Enable Timer1 使能定时器 1，默认关闭。 
Enable WatchDog 使能看门狗，默认关闭。 
Enable RTC 使能 RTC，默认关闭。 
Enable TRNG 使能 TRNG，默认关闭。 
Enable DualTimer 使能 DualTimer，默认关闭。 
Enable I2C 使能 I2C，默认关闭。 
Enable I2C I/O 使能 I2C inout 端口类型，默认使能 
Enable SPI 使能 SPI，默认关闭。 
Enable SD-Card 使能 SD-Card，默认关闭。 
Enable APB Master [1] 使能 APB Master [1]，默认关闭。 
Enable APB Master [2] 使能 APB Master [2]，默认关闭。 
Enable APB Master [3] 使能 APB Master [3]，默认关闭。 
Enable APB Master [4] 使能 APB Master [4]，默认关闭。 
Enable APB Master [5] 使能 APB Master [5]，默认关闭。 
Enable APB Master [6] 使能 APB Master [6]，默认关闭。 
Enable APB Master [7] 使能 APB Master [7]，默认关闭。 
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配置选项 描述 
Enable APB Master [8] 使能 APB Master [8]，默认关闭。 
Enable APB Master [9] 使能 APB Master [9]，默认关闭。 
Enable APB Master [10] 使能 APB Master [10]，默认关闭。 
Enable APB Master [11] 使能 APB Master [11]，默认关闭。 
Enable APB Master [12] 使能 APB Master [12]，默认关闭。 
Enable APB Master [13] 使能 APB Master [13]，默认关闭。 
Enable APB Master [14] 使能 APB Master [14]，默认关闭。 
Enable APB Master [15] 使能 APB Master [15]，默认关闭。 
Enable APB Master [16] 使能 APB Master [16]，默认关闭。 

 
GPIO 配置 

双击打开 GPIO，可以选择配置 GPIO，如图 3-11 所示； 

 如果选择 Enable GPIO，则 Gowin_EMPU_M1 支持 GPIO，默认关闭； 

 如果已经选择 Enable GPIO，则可以配置 GPIO 端口类型； 

 如果选择 Enable GPIO I/O，则 GPIO 支持 inout 输入输出端口类型，默

认支持。 
图 3-11 GPIO 配置 
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CAN 配置 

双击打开 CAN，可以选择配置 CAN，如图 3-12 所示； 

 如果选择 Enable CAN，则 Gowin_EMPU_M1 支持 CAN，默认关闭； 

 如果已经选择 Enable CAN，则可以配置 Buffer Depth； 

 选择 Buffer Depth，配置 Buffer Depth，默认值为 256。 
图 3-12 CAN 配置 
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Ethernet 配置 

双击打开 Ethernet，可以选择配置 Ethernet，如图 3-13 所示； 

 如果选择 Enable Ethernet，则 Gowin_EMPU_M1 支持 Ethernet，默认

关闭； 

 如果已经选择 Enable Ethernet，则可以配置 Interface、RGMII Input 
Delay、MIIM Clock Divider。 

- 选择 Interface，可以选择配置 RGMII、GMII、MII 或 GMII/MII，默

认为 RGMII； 

- 如果选择 Interface 为 RGMII，则可以选择配置 RGMII Input Delay，
默认值为 100； 

- 选择 MIIM Clock Divider，可以配置 MIIM Clock Divider，默认值为

20。 

 如果 Interface 选择 RGMII 或 GMII，则端口 GTX_CLK必须接入 125MHz
时钟输入。 

图 3-13 Ethernet 配置 
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DDR3 配置 

双击打开 DDR3，可以选择配置 DDR3，如图 3-14 所示； 

 如果选择 Enable DDR3，则 Gowin_EMPU_M1 支持 DDR3 Memory，
默认关闭； 

 DDR3 内部时钟频率 150MHz； 

 DDR3 端口 DDR_CLK_I，必须接入 50MHz 时钟输入。 
图 3-14 DDR3 配置 

 
 

SPI-Flash 配置 

SPI-Flash 支持下载功能，和 Memory 读、写、擦除功能； 

双击打开 SPI-Flash，可以选择配置 SPI-Flash，如图 3-15 所示； 

 如果选择 Enable SPI-Flash，则 Gowin_EMPU_M1 支持 SPI-Flash，默

认关闭； 

 如果 Gowin_EMPU_M1 使用片外 SPI-Flash 下载启动方式，则必须选择

Enable SPI-Flash。 
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图 3-15 SPI-Flash 配置 

 
 

AHB Master [1-6]配置 

双击打开 AHB Master [1-6]，可以选择配置 AHB Master [1-6]用户 AHB
总线扩展接口，如图 3-16 所示； 

 如果选择 Enable AHB Master [1]，则 Gowin_EMPU_M1 支持 AHB 
Master [1]用户 AHB 总线扩展接口，用户可以在此接口扩展 AHB 外部设

备，默认关闭； 

 如果选择 Enable AHB Master [2]，则 Gowin_EMPU_M1 支持 AHB 
Master [2]用户 AHB 总线扩展接口，用户可以在此接口扩展 AHB 外部设

备，默认关闭； 

 如果选择 Enable AHB Master [3]，则 Gowin_EMPU_M1 支持 AHB 
Master [3]用户 AHB 总线扩展接口，用户可以在此接口扩展 AHB 外部设

备，默认关闭； 

 如果选择 Enable AHB Master [4]，则 Gowin_EMPU_M1 支持 AHB 
Master [4]用户 AHB 总线扩展接口，用户可以在此接口扩展 AHB 外部设

备，默认关闭； 

 如果选择 Enable AHB Master [5]，则 Gowin_EMPU_M1 支持 AHB 
Master [5]用户 AHB 总线扩展接口，用户可以在此接口扩展 AHB 外部设

备，默认关闭； 
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 如果选择 Enable AHB Master [6]，则 Gowin_EMPU_M1 支持 AHB 
Master [7]用户 AHB 总线扩展接口，用户可以在此接口扩展 AHB 外部设

备，默认关闭。 
图 3-16 AHB Master [1-6]配置 

 
 

AHB Master [1-6]用户 AHB 总线扩展接口的起始地址和地址空间定义，

如表 3-3 所示。 
表 3-3 AHB Master [1-6]地址定义 
AHB 总线接口 起始地址 Size (MB) 
AHB Master [1] 0x80000000 16 
AHB Master [2] 0x81000000 16 
AHB Master [3] 0x86000000 16 
AHB Master [4] 0x89000000 16 
AHB Master [5] 0x8A000000 16 
AHB Master [6] 0x8B000000 16 
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UART 配置 

双击打开 UART0 或 UART1，可以选择配置 UART0 或 UART1，如图

3-17 所示； 

 如果选择 Enable UART0，则 Gowin_EMPU_M1 支持 UART0，默认关

闭； 

 如果选择 Enable UART1，则 Gowin_EMPU_M1 支持 UART1，默认关

闭。 
图 3-17 UART 配置 
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Timer 配置 

双击打开 Timer0 或 Timer1，可以选择配置 Timer0 或 Timer1，如图 3-18
所示； 

 如果选择Enable Timer0，则Gowin_EMPU_M1支持Timer0，默认关闭； 

 如果选择Enable Timer1，则Gowin_EMPU_M1支持Timer1，默认关闭。 
图 3-18 Timer 配置 
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WatchDog 配置 

双击打开 WatchDog，可以选择配置 WatchDog，如图 3-19 所示； 

如果选择 Enable WatchDog，则 Gowin_EMPU_M1 支持 WatchDog，
默认关闭。 
图 3-19 WatchDog 配置 
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RTC 配置 

双击打开 RTC，可以选择配置 RTC，如图 3-20 所示； 

如果选择 Enable RTC，则 Gowin_EMPU_M1 支持 RTC，默认关闭。 
图 3-20 RTC 配置 
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DualTimer 配置 

双击打开 DualTimer，可以选择配置 DualTimer，如图 3-21 所示； 

如果选择 Enable DualTimer，则 Gowin_EMPU_M1 支持 DualTimer，
默认关闭。 
图 3-21 DualTimer 配置 
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TRNG 配置 

双击打开 TRNG，可以选择配置 TRNG，如图 3-22 所示； 

如果选择 Enable TRNG，则Gowin_EMPU_M1 支持 TRNG，默认关闭。 
图 3-22 TRNG 配置 
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I2C 配置 

双击打开 I2C，可以选择配置 I2C Master，如图 3-23 所示； 

 如果选择 Enable I2C，则 Gowin_EMPU_M1 支持 I2C Master，默认关

闭； 

 如果已经选择 Enable I2C，则可以配置 I2C Master 端口类型； 

 如果选择 Enable I2C I/O，则 I2C Master 支持 inout 输入输出端口类型，

默认支持。 
图 3-23 I2C 配置 
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SPI 配置 

双击打开 SPI，可以选择配置 SPI Master，如图 3-24 所示； 

如果选择 Enable SPI，则 Gowin_EMPU_M1 支持 SPI Master，默认关

闭。 
图 3-24 SPI 配置 
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SD-Card 配置 

双击打开 SD-Card，可以选择配置 SD-Card，如图 3-25 所示； 

 如果选择 Enable SD-Card，则 Gowin_EMPU_M1 支持 SD-Card，默认

关闭； 

 SD-Card 端口 SD_SPICLK，必须接入 30MHz 的时钟输入。 
图 3-25 SD-Card 配置 
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APB Master [1-16]配置 

双击打开 APB Master [1-16]，可以选择配置 APB Master [1-16]，如图

3-26 所示； 

 如果选择 Enable APB Master [1]，则 Gowin_EMPU_M1 支持 APB 
Master [1]用户 APB 总线扩展接口，用户可以在此接口扩展 APB 外部设

备，默认关闭； 

 如果选择 Enable APB Master [2]，则 Gowin_EMPU_M1 支持 APB 
Master [2]用户 APB 总线扩展接口，用户可以在此接口扩展 APB 外部设

备，默认关闭； 

 如果选择 Enable APB Master [3]，则 Gowin_EMPU_M1 支持 APB 
Master [3]用户 APB 总线扩展接口，用户可以在此接口扩展 APB 外部设

备，默认关闭； 

 如果选择 Enable APB Master [4]，则 Gowin_EMPU_M1 支持 APB 
Master [4]用户 APB 总线扩展接口，用户可以在此接口扩展 APB 外部设

备，默认关闭； 

 如果选择 Enable APB Master [5]，则 Gowin_EMPU_M1 支持 APB 
Master [5]用户 APB 总线扩展接口，用户可以在此接口扩展 APB 外部设

备，默认关闭； 

 如果选择 Enable APB Master [6]，则 Gowin_EMPU_M1 支持 APB 
Master [6]用户 APB 总线扩展接口，用户可以在此接口扩展 APB 外部设

备，默认关闭； 

 如果选择 Enable APB Master [7]，则 Gowin_EMPU_M1 支持 APB 
Master [7]用户 APB 总线扩展接口，用户可以在此接口扩展 APB 外部设

备，默认关闭； 

 如果选择 Enable APB Master [8]，则 Gowin_EMPU_M1 支持 APB 
Master [8]用户 APB 总线扩展接口，用户可以在此接口扩展 APB 外部设

备，默认关闭； 

 如果选择 Enable APB Master [9]，则 Gowin_EMPU_M1 支持 APB 
Master [9]用户 APB 总线扩展接口，用户可以在此接口扩展 APB 外部设

备，默认关闭； 

 如果选择 Enable APB Master [10]，则 Gowin_EMPU_M1 支持 APB 
Master [10]用户 APB 总线扩展接口，用户可以在此接口扩展 APB 外部

设备，默认关闭； 

 如果选择 Enable APB Master [11]，则 Gowin_EMPU_M1 支持 APB 
Master [11]用户 APB 总线扩展接口，用户可以在此接口扩展 APB 外部

设备，默认关闭； 

 如果选择 Enable APB Master [12]，则 Gowin_EMPU_M1 支持 APB 
Master [12]用户 APB 总线扩展接口，用户可以在此接口扩展 APB 外部

设备，默认关闭； 
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 如果选择 Enable APB Master [13]，则 Gowin_EMPU_M1 支持 APB 
Master [13]用户 APB 总线扩展接口，用户可以在此接口扩展 APB 外部

设备，默认关闭； 

 如果选择 Enable APB Master [14]，则 Gowin_EMPU_M1 支持 APB 
Master [14]用户 APB 总线扩展接口，用户可以在此接口扩展 APB 外部

设备，默认关闭； 

 如果选择 Enable APB Master [15]，则 Gowin_EMPU_M1 支持 APB 
Master [15]用户 APB 总线扩展接口，用户可以在此接口扩展 APB 外部

设备，默认关闭； 

 如果选择 Enable APB Master [16]，则 Gowin_EMPU_M1 支持 APB 
Master [16]用户 APB 总线扩展接口，用户可以在此接口扩展 APB 外部

设备，默认关闭。 
图 3-26 APB Master [1-16]配置 
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APB Master [1-16]用户 APB 总线扩展接口的起始地址和地址空间定义，

如表 3-4 所示。 
表 3-4 APB Master [1-16]地址定义 
APB 总线接口 起始地址 Size (MB) 

APB Master [1] 0x60000000 1 

APB Master [2] 0x60100000 1 

APB Master [3] 0x60200000 1 

APB Master [4] 0x60300000 1 

APB Master [5] 0x60400000 1 

APB Master [6] 0x60500000 1 

APB Master [7] 0x60600000 1 

APB Master [8] 0x60700000 1 

APB Master [9] 0x60800000 1 

APB Master [10] 0x60900000 1 

APB Master [11] 0x60A00000 1 

APB Master [12] 0x60B00000 1 

APB Master [13] 0x60C00000 1 

APB Master [14] 0x60D00000 1 

APB Master [15] 0x60E00000 1 

APB Master [16] 0x60F00000 1 
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PSRAM 配置 

双击打开 PSRAM，可以选择配置 PSRAM，如图 3-27 所示； 

 如果选择 Enable PSRAM，则 Gowin_EMPU_M1 支持 PSRAM，默认关

闭； 

 如下器件（GW2AR-18/GW2AR-18C）支持 Gowin_EMPU_M1 PSRAM： 

- GW2AR-LV18QN88PES 
- GW2AR-LV18QN88PC8/I7 
- GW2AR-LV18QN88PC7/I6 
- GW2AR-LV18EQ144PES 
- GW2AR-LV18EQ144PC8/I7 
- GW2AR-LV18EQ144PC7/I6 
- GW2AR-LV18EQ144PC9/I8 

图 3-27 PSRAM 配置 
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综合工具配置 

完成 Gowin_EMPU_M1 功能配置后，选择产生 Gowin_EMPU_M1 的综

合工具 Synplify Pro 或 GowinSynthesis，如图 3-30 所示。 
图 3-28 综合工具配置 

  

3.3 用户设计 
 完成 Gowin_EMPU_M1 配置后，产生 Gowin_EMPU_M1 硬件设计； 

 实例化 Gowin_EMPU_M1 Top Module； 

 导入用户设计，连接 Gowin_EMPU_M1 Top Module 与用户设计，形成

完整的 RTL 设计。 

3.4 约束 
完成用户 RTL 设计后，根据使用的开发板和需要输出的 IO，产生物理

约束文件。 

根据时序要求，产生时序约束文件。 
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物理约束的产生方法，请参考 SUG101，Gowin 设计约束指南。 

3.5 配置 
3.5.1 综合选项配置 

综合选项配置，如图 3-29 所示。 

 选择综合工具 Synplify Pro 或 GowinSynthesis； 

 根据设计中的实际顶层模块名称，配置 Top Module/Entity； 

 根据设计中的实际文件引用路径，配置 Include Path。 
图 3-29 综合选项配置 

 

http://cdn.gowinsemi.com.cn/SUG101.pdf


3 工程模板 3.5 配置 

 

IPUG531-1.6 51(57) 

 

3.5.2 Post-Place File 配置 
如果使用 Gowin_EMPU_M1 软件编程设计和硬件设计自动化合并的下

载方法，则配置“Place & Route > General > Generate Post-Place File”选

项，产生 Post-Place File，如图 3-30 所示。 
图 3-30 Post-Place File 配置 
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3.5.3 Dual-Purpose Pin 配置 
如果Gowin_EMPU_M1使用片外SPI-Flash下载启动方式，则复用SSPI

和 MSPI 端口为通用端口，如图 3-31 所示，否则不需要配置端口复用。 
图 3-31 Dual-Purpose Pin 配置 
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3.6 综合 
运行高云云源软件的综合工具 Synplify Pro 或 GowinSynthesis，完成

RTL 设计的综合，如图 3-32 所示。 
图 3-32 综合 

 
 

综合工具的使用方法，请参考 SUG100，Gowin 云源软件用户指南。 

http://cdn.gowinsemi.com.cn/SUG100.pdf
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3.7 布局布线 
运行高云云源软件的布局布线工具 Place & Route，完成布局布线，产

生硬件设计码流文件，如图 3-33 所示。 
图 3-33 布局布线 

 
 

布局布线工具的使用方法，请参考SUG100，Gowin云源软件用户指南。 

http://cdn.gowinsemi.com.cn/SUG100.pdf
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3.8 下载 
运行高云云源软件的下载工具 Programmer，下载硬件设计码流文件。 

在高云云源软件中或软件安装路径中，打开下载工具 Programmer，单

击 Programmer 菜单栏“Edit/Configure Device”或工具栏 Configure Device
“ ”，打开“Device configuration”。 

如果开发板板载器件 GW1N-9/GW1NR-9/GW1N-9C/GW1NR-9C，则下

载选项配置，如图 3-34 所示。 

 “Access Mode”下拉列表，选择“Embedded Flash Mode”选项。 

 “Operation”下拉列表，选择“embFlash Erase, Program”或“embFlash 
Erase, Program, Verify”选项。 

 “Programming Options > File name”选项，导入需要下载的硬件设计

码流文件。 

 单击“Save”，完成硬件设计码流文件下载选项配置。 
图 3-34 GW1N 系列 Device configuration 

 



3 工程模板 3.8 下载 

 

IPUG531-1.6 56(57) 

 

如果开发板板载器件 GW2A-18/GW2A-18C/GW2AR-18/GW2AR-18C/ 
GW2ANR-18C/GW2A-55/GW2A-55C，下载选项配置，如图 3-35 所示。 

 “Access Mode”下拉列表，选择“External Flash Mode”选项。 

 “Operation”下拉列表，选择“exFlash Erase, Program”或“exFlash 
Erase, Program, Verify”选项。 

 “Programming Options > File name”选项，导入需要下载的硬件设计

码流文件。 

 “External Flash Options > Device”选项，请根据开发板板载 Flash 芯

片类型选择（如高云开发板板载 Winbond W25Q64BV）。 

 “External Flash Options > Start Address”选项，设置为“0x000000”。 

 单击“Save”，完成硬件设计码流文件下载选项配置。 
图 3-35 GW2A 系列 Device configuration 

 

完成 Device configuration 后，单击“Programmer”工具栏

Program/Configure“ ”，下载硬件设计码流文件。 

下载工具 Programmer 的使用方法，请参考 SUG502, Gowin 
Programmer 用户指南。 

http://cdn.gowinsemi.com.cn/SUG502.pdf
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4 参考设计 

Gowin_EMPU_M1 提供 Debug 和 No Debug 版本的参考设计： 

 Gowin_EMPU_M1\ref_design\FPGA_RefDesign\Debug_RefDesign 
 Gowin_EMPU_M1\ref_design\FPGA_RefDesign\NoDebug_RefDesign

http://cdn.gowinsemi.com.cn/Gowin_EMPU_M1.zip
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